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Adabas Audit Data Viewer

This section provides information on how to use Adabas Audit Data Viewer (AAV).

Introduction Provides a brief introduction to AAV and an overview of its components.

Installation Describes how to install AAV.

Login Describes how to run AAV and how to change the password.

User Profile Describes the user profile options.

Layouts Describes how to find a layout.

Logs Searching Describes how to search the logs.

Scheduled Reports|Describes how to schedule the generation of reports for offline data.

Error Messages Describes the error messages that may occur during the login process and while using
the application.
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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://documenta-
tion.softwareag.com.

Product Training

You can find helpful product training material on our Learning Portal at https://learn.software-

ag.com.

Tech Community

You can collaborate with Software GmbH experts on our Tech Community website at https://tech-
community.softwareag.com. From here you can, for example:
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About this Documentation

Browse through our vast knowledge base.

Ask questions and find answers in our discussion forums.

Get the latest Software GmbH news and announcements.

® Explore our communities.

® Go to our public GitHub and Docker repositories at https://github.com/softwareag and ht-
tps://containers.softwareag.com/products and discover additional Software GmbH resources.

Product Support

Support for Software GmbH products is provided to licensed customers via our Empower Portal
at https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

® Download products, updates and fixes.

® Search the Knowledge Center for technical information and tips.

" Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.

Data Protection

Software GmbH products provide functionality with respect to processing of personal data accord-
ing to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps
are documented in the respective administration documentation.
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2 Introduction

Adabas Audit Data Viewer (AAV) is a web tool for auditors to view logs stored in connected
databases. AAV allows you to filter data (based on specified search criteria) and display details
of the data found.

AAV system consist of the following components:

* Backend
The part of AAV that is not visible to the user of the web browser. The backend supports oper-
ations such as login or searching data, based on search criteria provided via the web client. The
backend is a part of the mainframe environment where the Adabas database is available.

® Web client
Frontend. The part of AAV that is visible to the user of a web browser after the user enters the
AAV web address (URL).
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Installation

The Adabas Audit Data Viewer installation package is provided as a WAR file that is to be installed
on a Java application server.

The tool has been tested with the following web browsers: Chrome 72.0+, Firefox 60.0+, IE 77.0+,
Safari 12.0+.

To ensure proper and secure use of AAYV, it is important to follow the installation and configuration
instructions of the chosen Java application server. The Java application server should only be in-
stalled, configured and operated by a qualified system administrator.

Configuring secure TLS communication is recommended, but is not part of this documentation.
For detailed information, see the documentation for your Java application server.

Installation Requirements

The following components must be installed:

® JDK (Java Development Kit) or JRE (Java Runtime Environment).

. -
Java application server.

Installation Package

The AAV installation package consists of the following parts:
" WAR file
Contains the AAV backend application that must be deployed on the Java application server.

® Web application
Contains static files and can be deployed on any web server (including the Java application
server).

Configuration Process

= AAV Backend Configuration

8 Adabas Audit Data Viewer



Installation

= AAV Frontend Configuration

AAV Backend Configuration

The backend configuration is stored in the application.yml file. The administrator can set the follow-
ing parameters in the application.yml file:

1.

bql.sql
Allows to enable SSL globally. Defines keystore and truststore paths and passwords. If set to
true, the (absolute) paths to the keystore/truststore must be provided.

bqgl:
ssl:

enabled: true

keystore:
path:
password:

truststore:
path:
password:

endpoints
® ip:IP address where the AAR subsystem can be reached (range: 10.0.0.0 - 10.255.255.255).

" port: port number of the AAR subsystem which is on the z/OS side and is defined by the
B97_TCPIP_PORT_AAV parameter (range: 0 - 65535).

" ssid: AAR subsystem ID.
" appl: application identifier (B97_AAV).

" ss1:defines whether the SSL connection is to be used. If this parameter is set to true, it must
also be enabled globally using the bq1.sql parameter. By default, it is set to false.

server:
tomcat:
basedir: tomcat
accesslog:
directory: Togs
enabled: true
pattern: common
endpoints:
Adabas_Data_Viewer_Demo_System:
ip:
port:
ssid:
aapl:
demo:
ip:
port:

Adabas Audit Data Viewer 9



Installation

ssid:
aapl:
ssl:

3. client: allowed-origins
Defines the URLs which can connect to the AAV backend. You can define the following values
for this parameter:

® Alist of allowed URLs, separated by a semicolon (;). For example:

client:
allowed-origins: "http://aav.serverl.com;http://aav.server2.com"

" An asterisk (*) to allow all URLSs. It is recommended that you only use this for test purposes.

client:
allowed-origins: "*"

4. user: inactivity
Defines the time (in seconds) of user inactivity after which a user is automatically logged out
of AAV.

user:
inactivity: 3600

5. folder: caching
This section of the application.yml file allows you to improve the system performance by enabling
the “folder tree caching mechanism”:

" interval: the time after which the list of database folders is updated with the latest data.
" enabled (true/false): enables/disables the caching mechanism.

" 1imit: determines the maximum number of user sessions for which the caching mechanism
is enabled. This parameter protects against overuse of server resources.

Example:

If the number of users exceeds a set value, then the last logged-in users take over the resources
of the first ones.

folder:
caching:
interval: 300
enabled: true
limit: 50

10 Adabas Audit Data Viewer



Installation

AAV Frontend Configuration

The configuration must be changed depending on how the frontend files are served. The frontend
configuration is available in the config.js file in the frontend directory. This file contains information
about the AAV backend (WAR) URL and the base path where the frontend is served. These values
are from the user's perspective, so the URLs and paths configured here are the publicly accessible
URLs as typed in browser's address bar, not local file system paths.

" Setting the API endpoint
API_URL defines the path or URL at which the API server is accessible. The URL can be relative
if the backend is hosted on the same domain or absolute if server is hosted on another domain.
When the AAV backend server is served from another domain, ensure that CORS is properly
configured so that it can be accessed.

For example, if the frontend is available at yourserver.com/aav and the backend server is on the
same domain at yourserver.com/aav-api, then set the API_URL variable as shown below:

window.config = {

/] ...

API_URL: '/aav-api',
/...

bs

If the backend is on a different domain, set API_URL to a full URL as shown below:

window.config = {

/...

API_URL: '//api.yourserver.com/aav',
/...

hs

" Setting the base path of the web app
BASE_PATH defines the path where the AAV web app is available on your domain. By default,
it is assumed to be available in the root directory (/). If it is installed in a subdirectory, you must
change the configuration as described below. If it is available at yourserver.com/aav, then set this
value to /aav:

window.config = {
/] ...

BASE_PATH: '/aav',
/] ...

b

In addition, you must also update the index.html file with the new path. Replace <base
href="/"/> with the following;:
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<base href="/aav/"/>

The path must end with a slash (/) character.

® Configuring routing
The AAV web app uses browser-side routing (HTMLS5 history). For this to work, your web
server must serve index.html at paths that do not exist. The AAV web app comes with a WEB-INF
directory that redirects all invalid paths to index.html, which should work with most Java applic-
ation servers.

Example of a Minimal Configuration in Tomcat

1. If not installed, install the Java Development Kit (JDK) or Java Runtime Environment (JRE).

2. If not installed, install Tomcat v.8.0+.

Links:
® JDK installation: https://www.oracle.com/java/technologies/javase-jdk14-downloads.html

® Tomcat installation: https://tomcat.apache.org/download-90.cgi

| Note: During the installation process, make sure that the versions of Java and Tomcat
(32-bit or 64-bit) match the operating system installed on the target computer.

3. Put the files from the AAV installation package in the Tomcat root folder (path_to_tomcat/).

| Note: The AAV installation package for Tomcat contains the additional file context.patch.

This file contains information about the updates that should be made to the context.xml
file. You can update the context.xml file manually (described in the next step) or automat-
ically (by executing the context.patch file).

4. Enable or disable the use of the SSL connection using the bql.sql parameter.
5. Define the endpoints:
® Update the context.xml file with the path to the application.yml file:
{Context>
'%ﬁ’arameter name="spring.config.location" value="path_to_application.yml/>
</ééﬁtext>

* Define the endpoints in the application.yml file. For example:

12 Adabas Audit Data Viewer
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endpoints:
Adabas_Data_Viewer_Demo_System:
ip: "10.56.83.100"
port: 49728
ssid: "A700"
aapl: "B97_AAV"

® ip:IP address where the AAR subsystem can be reached (range: 10.0.0.0 — 10.255.255.255).

® port: port number of the AAR subsystem which is on the z/OS side and is defined by the
B97_TCPIP_PORT_AAV parameter (range: 0 - 65535).

" ssid: AAR subsystem ID.
" appl: application identifier (B97_AAV).
6. In the conf/application.yml file, configure a c1ient allowed-origins.
This defines the URLs which can connect to the AAV backend. You can define the following
values for this parameter:
® A list of allowed URLs, separated by a semicolon (;). For example:

client:
allowed-origins: "http://aav.serverl.com;http://aav.serverZ2.com"

" An asterisk (*) to allow all URLSs. It is recommended that you only use this for test purposes.

client:
allowed-origins: "*"

7. In the conf/application.yml file, configure a user session inactivity parameter.

For example, if the user is to be logged out after 3600 seconds of inactivity:

user:
inactivity: 3600

8. In the conf/application.yml file, configure a folder caching parameter.
This section of the conf/application.yml file allows you to improve the system performance by
enabling the “folder tree caching mechanism”:
" interval: the time after which the list of database folders is updated with the latest data.
" enabled (true/false): enables/disables the caching mechanism.
" 1imit: determines the maximum number of user sessions for which the caching mechanism

is enabled. This parameter protects against overuse of a server resources.

Example:

Adabas Audit Data Viewer 13
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If the number of users exceeds a set value, then the last logged-in users take over the resources
of the first ones.

folder:
caching:
interval: 300
enabled: true
Timit: 50
9. Start Tomcat (if Tomcat was installed in step 2) or restart Tomcat.

10. Configure the config.js of the AAV web application.

Depending on the release contents:

= If the release package directory contains the page directory and app.war file (pre 1.0):

Set API_URL to /app and BASE_PATH to /page in config.js:

window.config = {
API_URL: '"/app',
BASE_PATH: '/page',
bs

And replace <base href="/"/> in index.html with the following;:
<base href="/page/"/>

= If the release package webapps directory contains the aav directory and the aav-api.war file
(starting with v1.0):

Set API_URL to /aav-api and BASE_PATH to /aav in config.js:

window.config = {
API_URL: '/aav-api',
BASE_PATH: '/aav',
b

And replace <base href="/"/> in index.html with the following;:

<base href="/aav/"/>

11. To configure the secured TLS connection, refer to https://tomcat.apache.org/tomcat-9.0-doc/ssl-
howto.html.
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Login

Running AAV

1. Enter the AAV web address (URL) in one of the supported web browsers (see Installation).

The AAV login screen appears:

Log in to your account

Endpoint
Select endpoint hd
Username
Password
®
Remember me Change password

2. Specify the following in the login screen:
® Select an endpoint.

® Enter your username (RACF user account).

] Note: RACF (Resource Access Control Facility) is the software whose main functions

are related to access control management, such as identifying and verifying users by
their RACF login and corresponding password, maintaining access rights to protected
resources, identifying and managing protected resources.

® Enter your password.

3. Click the Login button.

If the login details are correct, the main screen appears where you can perform further actions
(described in the next chapters).

16 Adabas Audit Data Viewer



Login

SOFTWARE AG
Adabas Audit Data Viewer

Q

T2 ADABAS_DATA_VIEWER_DAEA_SYSTEM

> SAGEW-CASE-FILE-GROUP-FOLDER

> FG-STAFF-208-01

> FG-CARS-208-02

> FG-DLF-LIST

> CASE_MANAGEMENT_SUPPORT_SYSTE

> AUDIT-EMPLOYEES

> AUDIT-VEHICLES

> AUDIT-FUSER

> ZPS_DEMO_DATA_FOLDER_GROUP

If the login details are not correct, an error screen appears informing you that your username

and/or password are invalid.

If the login attempt was made from a different network than the one where the server is running,

an error screen appears informing you that AAV could not connect to the server.

Changing the Password

1. In the login screen, click Change password.

The following screen appears:

Adabas Audit Data Viewer
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Login

< Change password

Endpoint
Select endpoint v
Username
userl
Old password
®
MNew password
®
Confirm new password
®

2. Do the following:
* Enter the old password.
* Enter the new password.
® Confirm the new password by entering it once more.

3. Click the Change button to save the new password.

18
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5 User Profile

The right side of the main screen displays the following icon which allows you to access the user
profile:

&
-
When you click this icon, the following is shown:

® Username

Displays the name of the user who is currently logged in.
= Settings

When you click Settings, the following screen appears:
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User Profile

Settings

Pooling time [seconds]

120

Defines interval in seconds at which the scheduled reports are updated.

Date format

European (DD.MM.YYYY)

Date format used in search forms and for results.
Changing this value may re-run current query.

List size limit

100

Limit of lists shown.

Hide all disabled (greyed out) fields

Show or hide all greyed-out fields which cannot be filled.

Close

You can specify the following settings:

Pooling time: the interval in seconds at which scheduled reports are updated.

Date format: the date format used in search forms and for results. Changing this setting may

cause the current query to be rerun.

List size limit: the maximum number of lists displayed in the search result.

Hide all disabled (greyed out) fields: when selected, fields that cannot be edited are not

displayed.

Click the Save button to save your changes.

Log out

If you click Log out, you are logged out of AAV.

20
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6 Layouts

The left side of the main screen displays the layouts, organized as a folder structure of tree elements.
The list of layouts and their contents depends on the databases connected to AAV.

To select a layout, do one of the following;:

® Expand the tree and then click the layout that you want to use. For example:

21



Layouts

SOFTWARE AG
Adabas Audit Data Viewer

Q

o ADABAS_DATA_VIEWER_DAEA_SYSTEM

> SAGEW-CASE-FILE-GROUP-FOLDER
FG-STAFF-208-01
FG-CARS-208-02
FG-DLF-LIST
CASE_MANAGEMENT_SUPPORT_SYSTE
AUDITEMPLOYEES
v AUDITEMPLOYEES-ALL-ACCESS

+ All Access to Employees File

> AUDIT-EMPLOYEES-SALARY-CHANGES
> AUDIT-EMPLOYEES-SENSITIVE-DATA
AUDIT-VEHICLES

AUDITFUSER

> ZPS_DEMO_DATA_FOLDER_GROUP

" Use the filter field at the top to find layouts with specific names. You can then expand the tree

and click the layout that you want to use. For example:

22
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Layouts

SOFTWARE AG
Adabas Audit Data Viewer

employees Q

o ADABAS_DATA_VIEWER_DAEA_SYSTEM

v AUDIT-EMPLOYEES
v AUDIT-EMPLOYEES-ALL-ACCESS
+ All Access to Employees File

> AUDIT-EMPLOYEES-SALARY-CHANGES

> AUDIT-EMPLOYEES-SENSITIVE-DATA

> ZPS_DEMO_DATA_FOLDER_GROUP

When you click a layout, the Search screen is displayed where you can add search criteria. See

Logs Searching for detailed information.

Adabas Audit Data Viewer
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7 Logs Searching

= Searching the Logs
= Refining the Search

= Possible Settings for Log SEarching ...........oooiiiiiiiiii s
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Logs Searching

Logs are searched based on the selected layout and by adding additional search criteria. The
available search criteria may be different for different layouts and depend on the connected data-
base.

Searching the Logs

1. Click the layout on the left side of the main screen.

A Search screen is displayed where you can add additional search criteria. The search criteria
are different for each layout.

Compare the following two example screens:

SOFTWARE AG AUDIT-EMPLOYEES-ALL-ACCESS » All Access to Employees File dD
Adabas Audit Data Viewer

Q

T= ADABAS_DATA_VIEWER_DAEA_SYSTEM

> SAGEW-CASE-FILE-GROUP-FOLDER

> FG-STAFF208-01 Search
> FG-CARS-208-02
Layout -
> FG-DLF-LIST | All Access to Employees File A |
> CASE_MANAGEMENT_SUPPORT_SYSTE From To
| 25.03.2024 (] | | 25.09.2024 ™ |

v AUDIT-EMPLOYEES

PERSONNEL-ID (Online)

APPLICATION PROGRAM (Online)
> AUDIT-EMPLOYEES-SALARY-CHANGES | |

v AUDIT-EMPLOYEES-ALL-ACCESS

s All Access to Employees File

> AUDIT-EMPLOYEES-SENSITIVE-DATA
USERID ACCESSING DATA (Online)

> AUDITVEHICLES |

> AUDIT-FUSER

> ZPS_DEMO_DATA_FOLDER_GROUP

The following screen displays different search criteria than the screen above.
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Logs Searching

SOFTWARE AG
Adabas Audit Data Viewer

Fitter Q

T2 ADABAS_DATA_VIEWER_DAEA_SYSTEM

> SAGEW-CASE-FILE-GROUP-FOLDER

> FG-STAFF-208-01

> FG-CARS-208-02

> FG-DLF-LIST

> CASE_MANAGEMENT_SUPPORT_SYSTEI

> AUDIT-EMPLOYEES

v AUDIT-VEHICLES

~ AUDIT-VEHICLES-ALL-ACCESS

+ All Access to Vehicles File

> AUDITFUSER

> ZPS_DEMO_DATA_FOLDER_GROUP

= select the layout from the tree on the left side of the main screen, or

AUDIT-VEHICLES-ALL-ACCESS > All Access to Vehicles File

Search

Layout

P

| Al Access to Vehicles File hd ‘
From To
| 25.03.2024 ™ | ‘ 25.09.2024 ™ ‘

REG-NUM (Online)

APPLICATION PROGRAM (Online)

USERID ACCESSING DATA (Online)

2. If you want to use a layout other than the one that is currently selected, either

" select the layout from Layout drop-down of the Search screen (if more than one layout is

available).

3. Add the search criteria.

D Notes:

a. To perform a search, you must add at least one additional search criterion besides the From

and To dates.

b. From the initial search, the fields that are not greyed out are global audit keys and must
contain a value to be searched for. This value may contain an asterisk (*) for alphanumeric

fields.

c. Global audit keys in the initial search screen must not contain double quotes (") or apostrophes

()-

4. Click the Search button to display the search result. For example:

Adabas Audit Data Viewer
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Logs Searching

SOFTWARE AG
Adabas Audit Data Viewer

Q

o ADABAS_DATA_VIEWER_DAEA_SYSTEM

> SAGEW-CASE-FILE-GROUP-FOLDER
> FG-STAFF-208-01
> FG-CARS-208-02
> FG-DLF-LIST
> CASE_MANAGEMENT_SUPPORT_SYSTE
~ AUDIT-EMPLOYEES
~ AUDIT-EMPLOYEES-ALL-ACCESS
+ All Access to Employees File

> AUDIT-EMPLOYEES-SALARY-CHANGES

> AUDIT-EMPLOYEES-SENSITIVE-DATA
> AUDIT-VEHICLES
> AUDITFUSER

> ZPS_DEMO_DATA_FOLDER_GROUP

AUDITEMPLOYEES-ALL-ACCESS > All Access to Employees File » First results

All Access to Employees File

Audit File

DEMOEMPL

DEMOEMPL

DEMOEMPL

DEMOEMPL

# Editsearch

Subscription Name

520805

520805

520805

520805

View Name

DEMO-EMPL-05

DEMO-EMPL-05

DEMGC-EMPL-05

DEMO-EMPL-05

Found 4 candidates.

Processing Date

2024-06-05

2024-06-05

2024-06-05

2024-06-17

e
2
@l a

Processing Time
14:57,:08:71
15:06:22:01
15:12:4549

23:22:38:96

| Note: If nothing matching your search criteria is found, a message is displayed indicating

that there is no data for your search criteria. You can then click the Edit search button

to display the Search screen again.

5. To reload the search result, for example, after an update of the list size limit (see User Profile),

&

click the refresh icon:

6. To set the height of the rows and select the columns to be displayed in the search result, click

the settings icon:

e}

Select the desired row height.

Row height

() Small
(® Medium

() Large

() X-Large

Select columns

To define, rename or reorder the columns that are to be displayed in the search result, click
Select columns. This displays the following:

28
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Field settings X

Search Q,

Restore default

= Audit File rd
= Subscription Name rd
= View Name 4
= [] Title rd
= Processing Date 4
= Processing Time 4
= [ ] Job Name 4
= [] JoblID d .

5 of 21 selected

Cancel Save

Select the check box for each column that is to be displayed in the search result.

To rename a column, click the pencil icon. Type a new name and press Enter, or click the save
icon that is shown next to the new name.

To move a column to a different position, drag the move icon (displayed to the left of the check
box) to the desired position.
Click the Save button to save your changes.

7. To find results that match your search, enter text in the Filter field (shown next to the settings
icon).

8. To change the search criteria, click the Edit search button at the bottom of the screen to display
the Search screen again (see the description above).
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Refining the Search

1. To refine the search result, select the check boxes for one or more search results. For example:

<

KO

&

O O

All Access to Employees File

Audit File

DEMOEMPL

DEMOEMPL

DEMOEMPL

DEMOEMPL

Subscription Name

520805

520805

520805

520805

View Name

DEMO-EMPL-03

DEMO-EMPL-03

DEMO-EMPL-05

DEMO-EMPL-05

Processing Date

2024-06-05

2024-06-05

2024-06-05

2024-06-17

2. Click the Refine search button at the bottom of the screen.

3. The Refine search screen appears. For example:

o0 ‘Fﬁ'ter Q

Processing Time

14:57:.08:71

15:06:22:01

15:12:45:49

23:22:38:96
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Refine search X
Layout =
All Access to Employees File v

PERSONNEL-ID (Online)

&

NAME (Online)

DEPARTMENT (Online)

JOB-TITLE (Online)

APPLICATION PROGRAM (Online)

| | -

4. Add more search criteria.

At this point it is possible to start a new search. This can be done by changing the layout.

The following applies if the Hide all disabled (greyed out) fields check box is selected (see
also User Profile): if one or more audit files are selected, only the fields that can be filled in are
displayed.

Only the fields that you fill in will appear in the refined search result. For example, if you add
search criteria only in the PERSONNEL-ID field, then only that field will be displayed.

5. Click the Search button to display the refined search result. For example:
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AUDIT-EMPLOYEES-ALL-ACCESS > All Access to Employees File » First results » Refine Search ltems & =
< Browse All Access to Employees File hits tems: 10 £ £}
Audit File Subscription Name View Name Processing Date Processing Time ltems
v DEMOEMPL 520805 DEMO-EMPL-05 2024-06-05 14:57:08:71 8
- DEMOEMPL 520805 DEMO-EMPL-05 2024-06-05 15:06:22:01 2

| Note: If a field for which you enter search criteria shows Offline next to its name, the

refined search result is not immediately shown. An additional screen is displayed instead,
see Scheduled Reports for detailed information.

6. To view the details of a specific list from the refined search result, click the list to expand it.

AUDIT-EMPLOYEES-ALL-ACCESS » All Access to Employees File » Firstresults > Refine Search ltems & =
< Browse All Access to Employees File hits tems: 10 5 £
Audit File Subscription Name View Name Processing Date Processing Time ltems
DEMOEMPL 520805 DEMO-EMPL-05 2024-06-05 14:57:08:71 8

ltem PERSONNEL-ID

1 50008600
2 50008500
3 50008300
4 20008200

7. Click an item in the list to view it.

The View item screen appears and you can now use the Prev and Next buttons to navigate
between the list items.
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View item - Find records [1/8] | Net | X

Data ACBX info 3

Download report

~ Info

adabasinternalSequenceNumber 184

summary Find records

userld 000ASBES85620001404040404040404000FED700C2D9I
auditld DB4F84114783FE12

description Return count and ISNs of records satisfying the search cr

-

Depending on your selection, the following tabs can be displayed in this view:

Data: relevant for commands that are not updates (Al).

Data before image: only relevant for update and delete commands (A1/E1).

Data after image: only relevant for update, delete and insert commands (A1/E1/N1).
ACBX info: always available.

Client info: always available.

FBUF: available for commands that include a format buffer and the subscription definition
includes FB set to Y in the associated command type. See also Step 4. Add Source Files and related
parameters to the Subscription Definition in Adabas Auditing Configuration (SYSALA).

Click Download report to download the search result for the selected list. The report is down-
loaded as a binary file. The file name is based on the schema
AAV_report_etoken_currentDate_currentTime.alog. AAV does not support the preview of
binary files.

Click the Edit search button next to the settings icon if you want to return to the Refine search
screen.
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Possible Settings for Log Searching

AAV IGR Display after "I" Online Option D.2 Explanation

Documentation

AAV AAR

AAV IGR-Display | Data Dictionary (Online Option D.2) Table IGR Explanation

Documentation |("I" online

Option 1)
Field Long Name Comment: Details:

Audit File Form FORM FORM FORM NAME Name of the
processed
data

Subscription |Extension |[EXT EXTENSION EXTENSION NAME Name of the

Name processed
data extension

View Name |Report REPORT

Title textstring |LTITLE LIST_TITLE LIST OR REPORT TITLE User's
description of
the processed
data

Processing  |Date B97DATE |B97_READER_INPUT_DATE B97 READER INPUT DATE Read-in date

Date of the
processed
data

Processing | Time B97TIME B97_READER_INPUT_TIME B97 READER INPUT TIME Read-in time

Time of the
processed
data

Job Name Jobname |SRCJOBN |SOURCE_JOBNAME SOURCE JOBNAME Batchjob on
the mainframe
that read-in
the processed
data

Job ID Jobid SRCJOBI SOURCE_JOB_JESID SOURCE JOB JES-ID JES-ID of the
batchjob that
read-in the
processed
data

Member Member |SRCMEMBR |[SOURCE_IMPORT_MEMBER |MEMBER NAME - IMPORT Membername
if an Import
was done
from a
PDS/library

34

Adabas Audit Data Viewer




Logs Searching

AAV IGR Display after "I" Online Option D.2 Explanatio
Documentation
AAV AAR
AAV IGR-Display | Data Dictionary (Online Option D.2) Table IGR Explanatio
Documentation |("I" online
Option 1)
Field Long Name Comment: Details:
Dataset Dataset |SRCDSN SOURCE_DATASET _NAME SOURCE DATASETNAME Name of
Name Name imported
PS,PDS o
read-in
JESSPOO
dataset
Submit User |Submit SRCSUBU  |SOURCE_SUBMIT_USER SOURCE SUBMIT USER-ID Submittes
User the batchj
that read-
the proce:
data
Submit Date |[Submit SRCSUBD |SOURCE_SUBMIT_DATE SOURCE SUBMIT DATE Date of th
Date submissic
Submit Time |[Submit SRCSUBT |SOURCE_SUBMIT_TIME SOURCE SUBMIT TIME Time of tl
Time submissic
Line Count |Lines SRCLNCZ |SOURCE_NUMBER_OF_LINES |[NUMBER OF LINES Number ¢
lines in th
processed
dataset
Layout Name of
Group Layout G
Online Online ONLRETPD |ONLINE_RETENTION_PERIOD |ONLINE_RETENTION_PERIOD |Online
Retention Retention retention
Period period of
processed
data
Index Index IDXRETPD |INDEX_RETENTION_PERIOD |[INDEX_RETENTION_PERIOD |Online
Retention Retention retention
Period period of
generated
index
Archive Archive |AEXPDT ARCHIVE_LIST_EXPDT ARCHIVE EXPIRATION DATE |Archive
Expiration  |Expiration expiratior
Date Date date of th
archived
Audit Data IGRONLNE [IGR_ONLINE (Y/N) LIST IS ONLINE YES/NO The proce
Online data is on
YES or N

Adabas Audit Data Viewer
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AAV IGR Display after "I" Online Option D.2 Explanation

Documentation

AAV AAR

AAV IGR-Display | Data Dictionary (Online Option D.2) Table IGR Explanation

Documentation |("I" online

Option 1)
Field Long Name Comment: Details:

Index Data IDXONLNE [IDX_ONLINE (Y/N) INDEX IS ONLINE (YES/NO)  |The generated

Online index is online
YES or NO

Tenant Owner OWNER OWNER OWNER The
ownerfield of
the IGR
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8 Scheduled Reports

You can schedule the generation of reports for offline data, that is, data that is not immediately
available, such as data stored on tape. The field names in the search screen indicate whether the

corresponding data is online or offline. For example:

Refine search X

Layout -

All Access to Employees File hd

PERSONMNEL-ID (Online)

*

NAME (Offline)

DEPARTMENT (Offline)

JOB-TITLE (Offline)

APPLICATION PROGRAM (Offline)

| | =
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If a field in the search screen shows Offline next to its name and you enter search criteria for this
field, the following screen appears when you click the Search button.

Scheduling report for All Access x
to Employees File

Would you like to wait for the results or to schedule
the process and view the results later?

This can take several minutes, because the relevant
data / index needs to be reloaded from the tape.

Scheduled report name

Report name

Cancel Schedule

You can now schedule the report by entering a report name and clicking the Schedule button.

When you schedule a report, the clock icon on the right side of the main screen displays the
number of scheduled reports. For example:

¢

The report is available after the pooling time which is defined in the user profile. When the report
is ready, the number on the clock icon turns green. Click the clock icon to see the name of your
report in a list. For example:

@]

Scheduled queries 1]

+ MyReport
Click the report name to display the refined search result. You can now proceed as described in
Refining the Search.

The report is not automatically deleted after you have viewed the search results. This must be
done manually. To do so, click the clock icon and then:

" click the x icon to delete a single report, or
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® click the trash can icon to delete all reports.
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9 Error Messages

The error messages are used to inform the user about problems that occurred while using the ap-
plication.

The error messages related to the database are presented with an error code from the database.
AAV supports the following error messages:

® During the login process:

® Your username and/or password are invalid

Appears when an incorrect password or username is entered during the login process.

® Could not connect to server

Appears when attempting to connect from a network other than the server network.
" An unknown error occurred during login (xxx)
Appears when the server responds to AAV with one of the following error codes: 400 or 500.

The error message in AAV contains a description of the error from the server (instead of
IIXXX// .

® Server not reachable
Appears when AAV cannot reach the server. This can happen if one of the following occurs:
the server is out of reach or the server is turned off.
® While using the application:
® Server not reachable
Appears when AAV cannot reach the server. This can happen if one of the following occurs:

the server is out of reach, the server is turned off, or the connection to the server's network
has been lost.

® Could not load the folders

41



Error Messages

Appears when AAV is unable to load folders into the tree element structure.

Could not load the schema for the view

Appears when AAV does not receive a schema corresponding to the selected view during
the global search (see also Logs Searching).

Could not load the schema

Appears when AAV does not receive a schema corresponding to the selected view during
the local search (see also Logs Searching).

Could not load data

Appears when AAV does not receive data from the server that corresponds to the search cri-
teria specified by the user.

Could not load user's settings

Appears when AAV does not receive information from the server about the settings of the
user who is currently logged in.

Could not save user's settings

Appears when AAV is unable to save the user settings due to a server error.

Could not load status of scheduled reports

Appears when AAYV is unable to load the status of scheduled reports from the server.

Index format is inconsistent. A Search is not possible on all selected lists.
Uncheck Tist causing the trouble and retry operation

Appears due to an inconsistency in the data format.
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